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Introduction
Carbon, hydrogen, nitrogen, and sulfur (CHNS) are fundamental elemental components that are analyzed on the ship during IODP expeditions. 
Fluctuations in the concentration and/or content ratio of carbon, nitrogen, and sulfur define the origin, depositional environment, and diagenetic 
alteration of source materials. A few options for sample preparation method, instrument settings, and measurement methodology exist. In addition to 
the pregenerated methods, specific analytical methodology may be required based on the nature of certain sample materials. In this case, new 
methods will be created by the laboratory technicians working in conjunction with the scientists. Each instrument method is recorded by the USIO and 
will be associated with the measurements performed under that method.

Carbon Analysis

Most marine sediments and sedimentary rocks contain both carbonate ("inorganic") carbon and organic carbon. The CHNS procedure measures total 
carbon (inorganic plus organic) when following the standard method. Organic carbon content is then determined by using the inorganic carbon value 
from coulometric analysis and calculating the difference between total carbon from CHNS analysis and inorganic carbon analyzed by coulometer. 
Alternative methodologies can be employed to measure organic and inorganic carbon.

Nitrogen Analysis

Nitrogen is one of the important limiting nutrients in the ocean. The global carbon cycle and, consequently, atmospheric CO  might be tightly coupled 2
to the nitrogen cycle, and therefore changes in the magnitude of the sinks and sources of fixed nitrogen in the oceans can significantly influence global 
climate. Biological nitrogen fixation, denitrification, and consumption of nitrate by phytoplankton are the major biological processes of the global 
nitrogen cycle. Changes in ocean circulation and nutrient supply, which occur in response to changes in environmental conditions, affect the relative 
importance and spatial extent of the major pathways of the nitrogen cycle.

Carbon-Nitrogen Relationship

C-N signatures indicate diagenesis and changes in productivity in seafloor sediments. Diagenesis may cause a decrease in C/N with decoupled C-N 
concentration variations, whereas productivity changes tend to produce C-N covariance in concentrations at relatively constant C/N ratios. Without 
significant superimposed diagenetic effects, linear relationships between C and N compositions can in some cases be interpreted as reflecting 
sources of organic matter:

C/N = 6–8: fresh marine organic matter
C/N = 8–20: degraded marine organic matter
C/N > 20: continental organic matter

Low C/N values occur in sediment that is poor in organic carbon; these values may be biased by the tendency of clay minerals to absorb ammonium 
ions generated during the degradation of organic matter. Sediments rich in TOC have higher C/N values than sediments lean in TOC. C/N values that 
are elevated above algal values are common in organic carbon-rich marine sediments. These values evidently result from the selective loss of 
nitrogen as organic matter settles from the photic zone because nitrogen-bearing proteins are more labile than other organic matter components such 
as carbohydrates and lipids. This type of preferential nitrogen depletion and consequent carbon enrichment is recognized in organic carbon-rich 
sediments. C/N elevations are most pronounced when TOC concentrations are highest, suggesting that a higher rate of organic matter delivery leads 
to diminished organic matter degradation.
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Sulfur Analysis

Cycling of sulfur compounds is a ubiquitous process in marine sediments that supports a range of microbial metabolic strategies. The occurrence of 
sulfur over a wide range of oxidation states (–2 to +6) allows sulfur species to serve as both electron acceptors and electron donors. In reduced form 
as sulfide (H S = H S  + HS ), sulfur is also an important sink for reactive iron. The reduction of sulfate to sulfide is by far the most important 2 2 (aq)

–

pathway for sedimentary organic matter oxidation in anoxic marine sediments, and there is evidence that anaerobic oxidation of methane controls 
microbial sulfate reduction (MSR) in many marine systems. 
Much of the sulfide produced during dissimilatory MSR in marine sediments is oxidized back to sulfate by a variety of biological and abiotic pathways, 
and sulfate produced by oxidation of sulfide may have variable isotope values reflecting the nature and complexity of the abiotic and biological 
oxidation pathways and relative contributions from different oxidants. These pathways often include the production of intermediate sulfur species such 
as elemental sulfur and thiosulfate, which can undergo further bacterial disproportionation reactions that may lead to further fractionations of both 
sulfur and oxygen isotopes in secondary sulfate. 
Elemental sulfur is a possible intermediate in pyrite formation and may serve as an indicator for active SO  reduction. Elemental sulfur enrichments 4

may form at places where the sulfide concentrations were high, resulting from in situ SO  reduction. Elemental sulfur forms from partial oxidation of 4
2–

sulfide. In addition, low-molecular-weight organic sulfur compounds are included in elemental sulfur.

Sulfur-Carbon Relationship

In normal marine sediments the relation between sulfur and carbon contents has a slope of 1/2.8 (S /C  ratio, wt%/wt%) and passes through the tot org
origin (assuming that sulfur fractions other than reduced sulfur are relatively negligible). In euxinic marine environments, however, sulfide is 
omnipresent (independent of local C  contents) and iron sulfide formation can take place in the water column or at the sediment/water interface.org
In addition, even slowly reacting iron compounds may react with sulfide in euxinic environments. Consequently, positive intercepts on the sulfur axis 
are obtained in sulfur vs. carbon plots for euxinic sediments, and only weak correlations may be observed. Additionally, post-depositional sulfidization 
of C -poor sediments may result in extremely high sulfur/carbon ratios.org

Theory of Operation

Dried and powdered samples are combusted in a tin sample crucible with vanadium pentoxide catalyst, purified by a reactor packed with electrolytic 
copper and copper oxide, separated on a gas chromatographic column, and analyzed using a thermal conductivity detector (TCD). Addition of the V O2 5
ensures complete conversion of inorganic sulfur in the sample to sulfur dioxide.

When the tin crucible with sample is dropped into the reactor, the oxygen environment triggers a strong exothermic reaction. Temperature rises to 1800°

C, causing the sample to combust. The combustion products are conveyed across the reactor, where oxidation is completed. Nitrogen oxides and sulfur trioxide are reduced to 
2 2 2 2~ flows into the chromatographic column, where elemental nitrogen and sulfur dioxide and oxygen excess is retained. The gas mixture containing N , CO , H O, and SO

separation takes place. Eluted gases are sent to the TCD where electrical signals processed by the  software provide percentages of Eager 300
nitrogen, carbon, hydrogen, and sulfur contained in the sample.

Apparatus, Reagents, & Materials

Hardware
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Carbon, hydrogen, nitrogen, and sulfur are analyzed on a Thermo Electron Corporation FlashEA 1112 CHNS elemental analyzer ( ) with Figure 1
autosampler ( ).Figure 2

Figure 1. Elemental Analyzer: (1) Furnace Access Door, (2) Synoptic Panel, and (3) Thermostatic Chamber Access. Dry Sample Autosampler 
is located on top of furnace.

Figure 2. Dry Sample Autosampler (red box in Figure 1): (1) Drum, (2) Gas Connection Fitting, (3) Gas Tube, and (4) Reactor Fitting..

Laboratory Apparatus

Agate mortar and pestle: well washed and dried
Chamber for freeze drier: well washed and dried
Dessicator and silica gel: use activated and well-dried silica gel
Medical paper
Mill (for hard rock samples)
Kimwipes
Sample holder: stainless steel with 50 numbered holes
Spatula
Spatula (general laboratory spoon): stainless steel, well washed and dried
Spring tweezers (2)
Tin containers (set of 100): Thermo Electron PN 240 064 00

Chemicals and Reagents

Be sure to read the Health, Safety, and Environment section before using any of the 
chemicals and reagents in this method.

Gases

Helium (carrier gas): chromatography grade
Oxygen (sample oxidation gas): 99.995% minimum purity



Page 5 of 16

1.  
2.  
3.  

4.  
5.  

6.  
7.  
8.  

Reagents

Note that many of these materials are hazardous and before any work is done with them, the user must be familiar with the appropriate Material 
Safety Data Sheets (MSDS).

Material Name Description Purpose

Aspartic acid C H NO : white fine crystals4 7 4 Standard reference material

2.5-Bis(5-tert-butyl-benzoxazol-2-yl)thiophene (BBOT) C H N O S: pale green crystals26 26 2 2 Standard reference material

Copper oxide Pre-packed Filling material

Electrolytic copper Pre-packed Filling material

Ethanol C H OH2 5 Solvent for sample preparation

Quartz wool SiO2 Filling material

Soil Reference Material Light brown powder Reference for N and C

Sulfanilamide C H N SO : white odorless crystals6 8 2 2 Calibration standard for CHNS and CNS

L-Cystine C H N O S : white odorless crystals6 12 2 4 2 Calibration standard

Vanadium pentoxide V O : yellow to red crystalline powder2 5 Catalyst

Magnesium perchlorate Mg(ClO ) : white granulate4 2 Filling material for water trap

Sample Preparation

Bulk samples are freeze-dried, crushed and homogenized using a mortar and pestle or electric mill, and weighed into a tin sample cup (crucible) with 
vanadium pentoxide catalyst. The crucibles are then closed (referred to as "wrapping" the sample) and placed in the autosampler for instrumental 
analysis.

Drying and Homogenizing the Sample

Break clumpy sample into pieces.
Fill a freeze-drying chamber with sample pieces and place into freeze dryer.
Freeze-dry sample for at least 12 hr until sample is completely dry (may require additional freeze-drying time, up to 3 hr). The sample is dry 
when there is no more condensate in the cold part of the tube.
Note: do not overload the freeze dryer; it will not dry properly.
Wipe an agate mortar and pestle with ethanol and allow to dry completely before grinding each sample. Be sure the mortar and pestle are co

 dry; ethanol reagent residue can cause false C and H results.mpletely
Grind and homogenize sediment using the cleaned  agate mortar and pestle.and dry
Fill a sample bottle with powdered homogenized sediment.
Place sample bottle into the desiccator. Many mineral species are hygroscopic (tend to absorb water), so the sample bottles containing the 
dried samples should be kept in the desiccator until used.

Sample Volume

Because the balance system is of unknown lower precision aboard ship than in a shore-based laboratory, we recommend 6–9 calibration points to 
obtain a high CHNS measurement precision. The usual quantities of sample materials and standards used are as follows: 
–Vanadium pentoxide: ½ of small spatula for blank, standard, and unknown samples 
–Standard (sulfanilamide):

3.0 mg × 2 to 3 replicates
5.0 mg × 2 to 3 replicates
7.0 mg × 2 to 3 replicates
Note  Sulfanilamide is not necessarily the right standard for a given set of samples: try to bracket your unknown samples with the standards :
for each element of interest.
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–Standard sediment or sulfanilamide (for QA/QC evaluation; see ): 11 mg, minimum 10 pieces may be required for Quality Assurance/Quality Control
one sequence of the measurement.
–Unknown samples: The amount used depends on the nature of the sample material. If material is unusual, it may be necessary to weigh out several 
different quantities of sample to correctly analyze the material. Typical masses of some materials are:

Hemipelagic sediments: 11–12 mg
Pelagic sediments (low productivity): 11–15 mg
Upwelling area (high productivity area): 10–12 mg

Clean Preparation Equipment

Wipe spatula, spring tweezers, balance, and other stainless equipment with ethanol between each sample. Be sure these are completely dry before 
.using to avoid contaminating samples

Weighing and Wrapping Samples

Double-click the  icon.Cahn Balance
Log into the system by entering LIMS user name and password.
Enter 200 as the Count Limit.
Place an empty crucible (tin container) on the REFERENCE balance pan (right pan).
Place a new crucible into the small hole of the metal plate.
Open the upper half of the tin cup and place a crucible on the UNKNOWN balance pan (left pan).
Tare the balance using the software. (Do  press the Tare button on the Cahn balance.)not
Click  to start weighing.Start
Once the mass volume is acceptable, click .Get Mass
Remove the crucible from the UNKNOWN balance pan, place the crucible on the metal plate, and place the appropriate amount of sample 
material (see ) into the crucible.Sample Volume

NOTE: DO NOT use the holes on the metal plate if any standard material is spilled in or near it because even a small amount of standard may 
contaminate the measurement.

Place crucible with sample material back on the UNKNOWN balance pan and close door.
Click  and .Weigh Start
Click  if the mass value is acceptable.Get Mass
Enter any part of a sample ID or Label ID and click .Search
Select the sample that was just weighed from the list and click .Assign
Enter a container number (sample holder number, not an autosampler number) in the  field.Container#
Click .Save

Sample Analysis

Data flow for CHNS sample analysis includes the following:

Prepare the instrument for running samples (see ).Preparing the Instrument
Confirm instrument calibration (see ).Verifying Instrument Calibration
Export LIMS file from LabWare for CHNS (see ).Creating the Sample Table
Import LIMS sample table and edit (see ).Uploading the Sample Table to Eager 300 Software
Start sequence (see ).Running Samples
Summarize, edit, and analyze results (see ).Analyzing Data
Export sample data as CSV file and upload to LIMS (see ).LIMS Integration

Preparing the Instrument
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The shipboard technician will set up and maintain the reactor and gas chromatographic column. The technician will also instruct the scientist on the 
operation of the instrument. 
Instrument startup and conditioning are conducted by the shipboard technician, who also loads the analytical configuration (method). If a specific 
analytical configuration is required because of the nature of the samples, scientists should collaborate with the technician to develop the analytical 
method and run parameters. When the instrument is ready, the  screen displays. To confirm the status of the CHNS analyzer Eager 300 CHNS
instrument, select  >  (see Figure 4, below).( ). Analytical determination takes approximately 40, 100, View View Elemental Analyzer Status Figure 3
150, and 640 seconds for nitrogen, carbon, hydrogen and sulfur, respectively, for a 2 m long separation column. The integration time should be set to 
approximately 15 min (900 sec) for runs in which sulfur is measured due to the breadth of the signal peak. Either purchase pre-filled reactor columns 
or prepare them according to the manufacturer's instructions. The adsorption filter should be filled with fresh magnesium persulfate regularly. The 
JRSO uses pre-packed reactor columns from CE Elantech and Costech; these have always proved to be of high quality, without gaps or faults in the 
reagents that could lead to a poorly-reacted gas stream.

If pre-filled reactor columns are not available, follow the instructions in the Flash EA 1112 vendor manual to prepare them. Packing columns is in 
Chapter 5 of the vendor manual; installing reactor and adsorption columns is discussed in Chapter 6. Note that the JRSO uses CE Elantech 061110 
columns for sulfur, loaded with copper and tungsten oxide, but many other options are possible.

A general schematic is shown below in Figure 3. Prepare the EA reactor, adsorption filter, and chromatographic column for the desired analytical 
elements according to the following schematic:
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 Figure 3: Analytical equipment setup based on desired elements.
Properties of reactor materials and adsorption filter: Copper oxide/chromium oxide: Creates an oxidizing environment during combustion of the 
sample. Vanadium pentoxide: Catalyzes the combustion of S (as sediment ion sulfate/sulfides) to sulfur dioxide. Tungsten oxide (WO ): Helps 3
complete the oxidation of combustion products to final products.

Electrolytic copper: Reduces potentially formed nitrogen oxides and sulfur trioxide combustion products to elemental nitrogen and sulfur dioxide. 
Silvered cobaltous/cobaltic oxide: Catalyst used to remove sulfur dioxide and halogens. Magnesium perchlorate (anhydrone): Desiccant which 
removes water (i.e., combusted H) in the adsorption filter.
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Figure 4. Eager 3000 CHNS Screen.  

Verifying Instrument Calibration

The CHNS instrument is calibrated at the beginning of each expedition (see ). Calibration is verified before Quality Assurance/Quality Control
running each sample sequence by running a blank and a calibration verification standard against the current calibration curve.

Reset the Calibration Factor

On the  screen, select  >  and then click .CHNS Recalculation Reset Calculation Factors OK
Double-click on  and enter LIMS user name and password to activate CHNS.exe CHNS Loader.
Select the  tab.Output Sample from LIMS
Select calibration standards, which have analysis codes  and verification code  with one blank to be run in the next CHNS QAQC Standard,
batch or sequence.
Row number (located at the right bottom of the window) must be 1.
Click  to create the LIMS file.Export
Save LIMS file into the folder where you saved the method.

Upload LIMS file to Eager 300 software

On the  screen, select .CHNS Edit > Sample table
From the menu at the top of the sample table, select .Edit sample > Import sample table from LIMS
Select an appropriate file and click  to upload file.OK
Click  to escape the window.Cancel

Edit the calibration curve sample table (Figure 4)

Select an appropriate standard name (e.g., ).Sulfanilamide
Ensure the order of the container number (see the end of ) is correct.Filename
Click  to close window.OK
Select  on the  screen to save changes. (Calibration data will be saved into LIMS with the first batch of unknown File > Save Method CHNS
sample measurements.)
On the  screen, click the green arrow toolbar icon to analyze the blank and standards.CHNS
Confirm blank: during the blank run, select  >  from the  screen. If the chromatogram has View View sample being acquired CHNS
unexpected peaks or a disturbed baseline, the cause of this problem must be determined before unknown samples can be run.

Confirm the Calibration Curve (Figure 5)

On the  screen select CHNS View > View Calibration curve.
Click  to change curve components (color of selected component will change to blue).Component
Check calibration factor.
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Calibration method can be changed on this screen. For more information see the FlashEA 1112 Operating Manual (p. 232).
If the calibration factor is acceptable (see ), unknown samples can be run. If the calibration factor is outside of Quality Assurance/Quality Control
control limits, the laboratory technician will edit the component table and integration parameters and recalculate the calibration factor.

Figure 5. Sample Table.

Figure 6. Calibration Curve.

Creating the Sample Table

Double-click on .CHNS.exe
Enter the LIMS user name and password to activate .CHNS Loader
Open the  tab.Output Sample from LIMS
Click column header  (samples are sorted by container number).Container
Select samples to be run in the next batch or sequence.
Adjust row index. Row index number must be the same as the row number that is two rows below the last sample in the current sequence 
table of the  software.Eager 300
Click  and save file to the folder where you saved the method.Export
Exit the .CHNS Loader
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Uploading the Sample Table to  SoftwareEager 300

On the  screen, select .CHNS Edit > Sample table
From the menu at the top of the sample table, select  ( ).Edit sample > Import sample table from LIMS Figure 6Figure 7
Select appropriate LIMS file, and click  to upload file.OK
Click  to escape the window.Cancel
Make sure sample holder number is correct.

Figure 7. Edit Sample Menu.

Running Samples

To start running samples, click the green arrow toolbar icon on the  screen.CHNS
To monitor the acquisition status, select  >  ( Figure 8).View View sample being acquired Figure 7
Once samples are run,  shows a single selected chromatogram;  is better suited for View Chromatograms Overlay Chromatograms
comparison of chromatograms (maximum of five).
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Figure 8. View Menu.

Analyzing Data

QA/QC data is captured by LIMS, but the technician should monitor QC values from the calibration verification (CV) standards and determine if 
corrective action should be taken.
After analyzing the standard and checking the instrument precision, complete the following steps.

On the  screen, select  ( ).CHNS Recalculation > Summarize results Figure 8Figure 9
Select a group of samples to calculate the standard deviation for by indicating a group number (1) in the Group column of the Summarize 

 table. For example, in   the 6 sulfanilamide standards are grouped (1) for standard deviation analysis.results Figure 8 Figure 9
With the mouse, select the first row of a group (Row 2 in ) and select  to see statistical data Figure 8Figure 9 View > Statistical Calculation
calculated for that group.
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Figure 9. Summarize Results Screen.

Quality Assurance/Quality Control

A program of quality assurance/quality control (QA/QC) ensures that a measurement system is performing within control limits and therefore provides 
high-quality data. The QA/QC program for this system includes instrument calibration and calibration verification, blank verification, and accuracy and 
precision monitoring.

Instrument Calibration

The CHNS instrument is calibrated by the chemistry technician at the beginning of the expedition. Calibration is verified routinely during operation by 
running calibration verification standards (see ).Calibration Verification

Sequence

An analytical sequence is a group of sample runs sharing a calibration curve, blanks, reference materials, and verification samples. One sequence 
(table) allows a maximum of 200 samples.

Analytical Batch

An analytical batch is a group of samples run together. Each CHNS batch of unknown samples contains a calibration verification sample, calibration 
blank, and known sample.

Calibration Blank

A calibration blank run each sequence consists of a tin cup containing only reagent V O  catalyst to assess the effect that the tin cup and catalyst 2 5
have on the analysis results. If the blank chromatogram has unexpected peaks or a disturbed baseline, the cause of this problem must be determined 
before unknown samples can be run. Notify the chemistry technician.
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Calibration Verification

The calibration verification standard, also called the QC check standard, is run with each analytical batch and contains 20.6–0.7 g of BBOT in a tin cup with V O
5~ catalyst. If the calibration factor is within control limits, unknown samples can be run. If the calibration factor is outside of control limits, edit the 

component table and integration parameters and recalculate the calibration factor.
Poor calibration verification results can also indicate degradation of the reactor. If calibration cannot be verified, notify the onboard laboratory specialist.

Precision

Precision is the degree to which further measurements will show the same or similar results. To analyze for precision on this system, a standard 
(sulfanilamide, BBOT, or aspartic acid) is run in duplicate or triplicate and the standard deviation of the results calculated for each element:

where  = average of results,  and  = number of data points.  N

Accuracy

Accuracy is the degree of closeness of a measured value to the actual (true) value. A standard of sulfanilamide in a tin cup with V O  catalyst is run 2 5
with each sequence to verify accuracy. Results of the standard must be within ±10% of true values for the system to be considered in control. 
Sulfanilamide true values and control limits:

C = 41.848% (37.663%–46.033%)
H = 4.685% (4.217%–5.154%)
N = 16.267% (14.640%–17.894%)
S = 18.620% (16.758%–20.482%)
O = 18.582% (16.724%–20.440%)
Other materials (e.g., USGS reference sediments) can be used to measure accuracy, so long as their values are known.

LIMS Integration

Sample/Analysis Components

Analysis code Component name Unit Definition

CHNS carbon_percent wt% Carbon concentration in sample

  container_number — Number assigned to weighed sample

  dat_asman_id — ASMAN serial number for data file

  dat_filename — Filename of data file

  hydrogen_percent wt% Hydrogen concentration in sample

  mass mg Mass of sample

  nitrogen_percent wt% Nitrogen concentration in sample

  run_test — Test number of related calibration

  sulfur_percent wt% Sulfur concentration in sample

When uploading data enter the term "Rejected" in place of the value for an elemental concentration for a sample or series of samples that followed a 
running standard in which the analytical error exceeded the QA/QC limits (10% for each element). This displays "Rejected" in LIMS/LORE for only that 
specific sample element and still keeps intact the excel file containing the raw data which is uploaded to the database.

Health, Safety, & Environment
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Safety

General

Before using the gases, chemicals, and filling materials required for this procedure, carefully read the MSDS for that material.
Proper personal protective equipment must be used for handling all apparatus and materials in this procedure.
The instrument has a safety cutoff feature that cuts power to the furnace heating elements if the instrument malfunctions due to a component 
failure or abnormal operating conditions. If the red safety LED indicator on the synoptic panel is illuminated, contact laboratory staff 
immediately.

Warnings

WARNING! Do not open the furnace compartment during operation.
WARNING: Do not touch either furnace when the furnace temperature is higher than 40°C. Furnace temperature is shown in the EA 1112 

 screen (Select ).Status View > View Elemental Analyzer Status
WARNING: Do not open the protection panel. The gas chromatographic column may only be serviced by the shipboard technicians.

Compressed Gases

Gas cylinders are pressure hazards and should be changed only by shipboard staff. High-pressure gas lines can be hazardous if there are 
leaks, particularly the oxygen line.
United States standards for inert gas and oxidation regulators exist to physically prevent the user from hooking an oxidizing gas (e.g., O ) to 2
an inert gas line and vice versa. Always use the appropriate CGA fitting for each gas! The JRSO uses the following fitting types for the gases 
used in this method:
Inert Gas (Helium): CGA 580 (male, right-hand threading)
Oxidizing Gas (Oxygen): CGA 540 (female, right-hand threading)
Adapters do exist to convert one gas fitting to another: do not use them! The gender and threading direction of the standard fittings are 
designed to protect the user.
Gas cylinders should always be restrained at two points by a strap or chain. In the case of single cylinders at use in the laboratory, do not 
share a strap or chain between two cylinders: each cylinder should have its own restraining gear. In the case of the gas racks in the hold, 
consult with the Laboratory Officer  attempting to separate a gas cylinder from the rack.before
Specific Gas Descriptions
Oxygen is an odorless colorless gas that is a strong oxidizer. An oxygen leak could cause spontaneous combustion if an organic source is at 
hand. Always check the O  lines for leaks. Appropriate precautions should be taken.2
Helium is an odorless colorless inert gas. Rapid release of He from a cylinder could potentially asphyxiate the user, so appropriate 
precautions should be taken.

Chemical Safety

Many of the chemicals used in the CHNS procedure, including the standards, present potential chemical hazards. Always read the material safety 
data sheet (MSDS) of each and every chemical before working with them. Some of the highest-hazard chemicals are summarized below:

Magnesium Perchlorate

Extremely Strong Oxidizer!; keep away from organic materials and mineral acids
Air and Water Reactive!

Highly exothermic upon addition of water
Absorbs water from air
May explode under prolonged exposure to heat
Will increase intensity of a fire

Health hazard:

Inhalation: irritant
Contact: irritant
Ingestion: abdominal pain, vomiting, diarrhea, may be fatal

Vanadium Pentoxide

Extremely toxic! Always use the appropriate personal protective equipment (PPE) and environmental controls when 
using this chemical.

Harmful if swallowed or inhaled
Causes serious eye damage
May cause respiratory irritation
Suspected of causing genetic defects, damaging fertility, and/or harm of the unborn child
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Causes damage to internal organs through prolonged or repeated exposure
Toxic to aquatic life with long-lasting effects

General

Before using the gases, chemicals, and filling materials required for this procedure, carefully read the MSDS for that material.
Proper personal protective equipment must be used for handling all apparatus and materials in this procedure.
Gas cylinders are pressure hazards and should be changed only by shipboard staff. High-pressure gas lines can be hazardous if there are 
leaks, particularly the oxygen line.
The instrument has a safety cutoff feature that cuts power to the furnace heating elements if the instrument malfunctions due to a component 
failure or abnormal operating conditions. If the red safety LED indicator on the synoptic panel is illuminated, contact laboratory staff 
immediately.

Warnings

WARNING! Do not open the furnace compartment during operation.
WARNING: Do not touch either furnace when the furnace temperature is higher than 40°C. Furnace temperature is shown in the EA 1112 

 screen (Select ).Status View > View Elemental Analyzer Status
WARNING: Do not open the protection panel. The gas chromatographic column may only be serviced by the shipboard technicians.

Pollution Prevention

Degree of pollution according to IEC 664 = 2

Waste Management

This procedure generates no waste for disposal beyond the standard chemistry laboratory protocols..
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